PowerPoint 2007: Introduction

Microsoft Office'gutton Quiik/Acess Toolbar Additional Tabs
A= ORI L Nessristant: < Nictoiam BousiDeiit
Tabs: Ly Home | fset  Dengn  Anmsbions  ShdeThow  Rewey fiew  Developsr Adddns St Started
Commands: —» | _—""';u.'- Calibri Headingt = (#0  « EA0 AT [[#)) 3= = ==l S| 1= Hﬁ
Groups of P g | o e BT U RSN uA EEEZEE .
actions: ¥ fupnond - I

Click down-arrow for more commands

1. Open PowerPoint
The Microsoft Office Button provides access to opening new and previous documents, saving,

a.

~oapoo

g.

a.

printing, and PowerPoint options
The Home tab provides the most used commands

The Insert tab provides access to inserting a picture, clip art, table, hyperlink, and etc.

The Design tab provides access to slide themes, and etc.
The Animations tab provides access to Custom Animations options
The Slide Show tab provides access to options for starting and setting up the show

The Get Started tab provides several online resources for learning to use PowerPoint 2007
2. Saving a PowerPoint Document

Click on Microsoft Office Button; select Save

b. A document created in PowerPoint 2007 will be saved with .pptx as the extension (older version

documents are saved with .ppt as the extension)

3. Opening Documents from Previous Versions:

C.

PowerPoint 2007 will open documents from all
previous versions of PowerPoint, i.e, a .ppt

document s5s Release '.!-.'--ifi:--='=.*:-;r:i'i!ar-- I !:'.-n'.!e) Microsoft Waorc

Documents will open in Compatibility Mode out References Mailings Review View

When editing these documents, many new 2007
features will not be available

Doing a Save will not change the document to the
new file format: .pptx

4. Converting Older Documents to Version 2007: i.e., .pptx

g.

Open a PowerPoint document from a previous version, i.e., .ppt ; it will open in
Compatibility Mode

Click on the Microsoft Office Button

Select Convert; a message will appear explaining the conversion issues

Click OK; document will be converted to PowerPoint 2007 document, i.e., .pptx
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5. Sharing PowerPoint 2007 Documents
k. When a person without PowerPoint 2007 opens a .pptx e i

document, a message will appear A\ T et was croated by 3 nowen
. . version off Microsolt Wied, Do you want
I. If the person has Office 2000 or 2003, they can click Yes and R ko a4 Corivertin v B Youriss

a converter will be downloaded and the document can be o ki i

viewed and edited, though it may appear a little different
m. The older version of Office needs to be updated with the
latest patches in order for converter to work.
6. Saving a PowerPoint 2007 Document as a Previous Version
n. With the PowerPoint 2007 document open, click on {5} —
the Microsoft Office Button =
0. Click on the down-arrow next to Save As...

'. '_tl.-s | Ho | | Canced

Sawe 2 009y of INe doCumen

- Word Document
p. Select the PowerPoint 97—2003 Document option Euac i | e e S
g. The document will be saved as a .ppt document that (575 Word Template
i. A warning may appear saying that any new Wig) comen S o X TRt
features of Word used in the document will be 1. sl Word 972003 Document | 2
seen but cannot be edited "_4 S | ' Save p com of B dowtians st
ii. Click OK and document will be saved as .ppt j,.i — [% . Ear.c:;:nzp.s o
and can be opened by anyone with a previous S psile T e coRmERa
version of PowerPoint L
- Hame : Insert | Fage Layou | Beferemees’| Mailings | Review | View &dd-dng || Gat Skarted) Sdrak
7. Get Started i £ls ~ 25 w3l £ 6
r. Click Get Started tab s | et g I N 5 B Sl
Gruzda with WWor T HF? E "

s. Click Interactive Guide, Start the Guide to show where commands in PowerPoint 2003 are located
in PowerPoint 2007; this can be very helpful to find tool locations; click Start the Guide

t. Click Up to Speed with PowerPoint 2007, go through series of audio/visual lessons; get instruction
on basics of PowerPoint 2007; can be very helpful in getting an overview of main features of
PowerPoint 2007

u. Click PowerPoint 2007 Overview or Get up to Speed with PowerPoint 2007 to view videos; these
use a business context for using PowerPoint; click Play Demo

v. Click Discuss PowerPoint 2007 to read questions and responses by others using PowerPoint 2007,
and other online resources

w. Click Training; under 2007 Office System Courses, click on PowerPoint 2007 to access the many
feature-specific courses; these can be very helpful to learn specific Word skills

x. Click Video Demos; click 2007 Office System tab; click PowerPoint 2007 to access feature-specific
videos; these are more business related; may relate to other Office applications

y. Click PowerPoint 2007 to access the Help Table of Contents for a variety of general problems

TIP: When in doubt about how to do something, try right-clicking and see if a menu of options appears

TIP: Click on the ? in upper right hand corner of the PowerPoint window; use key-word search or click on topic
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Beginning a PowerPoint Presentation:

1. Initial steps:
a. Open PowerPoint; a blank slide appears
b. Click Save icon in Quick Access Toolbar, and complete saving process
c. Click on Design tab; in Themes group, click on ¢ ] Design | Animstions. ShdeSHow Fefiew
down arrow to view available themes Aa ' s | I‘
d. Roll cursor over themes to preview them; clickon | smomer || aee ‘ meme |22
desired theme B

|E P

e. Click on Click to add title, enter text; Click to add subtitle and enter desired text
i. Highlight text to edit
1. Click Home tab; click on font name; roll cursor over font names to preview; click on
desired font
2. Click big A to increase font size; click on little A to reduce font size to desired size
3. Select desired font style; select desired font color
f. To move title and/or subtitle, click on desired text; place cursor over dotted outline (four-arrow
cursor will appear); click and drag to desired place on slide
2. Add new slide — bulleted list
a. On Home tab, click New Slide icon Tk
b. Click on New Slide; a new slide appears o Frew =
c. To change the layout, click the down-arrow in lower ' Hw
right corner of New Slide button to view options

d. Select desired layout [ =
e. Click on Click to add title and enter desired text; highlight text and change font, style, size and
color, using the mini toolbar, and/or the Font group on Home tab
f. Click on Click to add text and enter text for the bullet
Tip: Use WordArt Styles to invigorate text; click in textbox, click on Drawing Tools Format tab, click on
Quick Styles (or down-arrow by right above WordArt Styles), move cursor over As to preview font
styles; click on desired font style
g. Press Return and enter text for the second bullet; continue to add additional bullets and text
h. Highlight text to change:
i. Bullets; press down arrow by Bullet icon; select Bullets and Numbering; choose from ones
displayed (alter bullet size and color), or click on Picture or Customize to find more bullets
ii. Font, style, size and color
3. Add new slide — Insert Picture
a. On Home tab, click New Slide icon
Click on New Slide; a new slide appears
Click Insert Picture icon (or Clip Art) icon
Navigate to desired picture; click Insert
(Another way is to click on Insert tab and click on
Picture or Clip Art) : ;
e. Picture Tools and Format tabs appear to provide ' - 5 || Click 10 add ttle
options to work with picture 112 | " . €

oo o
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i. Use Adjust commands to alter pictures/clip art
ii. Use Picture Styles commands to add and alter frames
iii. Use Arrange commands for layering pictures
iv. Use Size commands to crop the picture
f. Click and hold on picture to move it
g. Click and drag a corner handle to resize picture
h. Click and drag the top green circle to rotate picture

4. Compress Pictures
a. Click on a picture; Picture Tools Format tab will x Drighiness * ]
appear; click Compress Pictures

b. Click Options button
i. Under Compression options:
1. Check Automatically perform basic compression on save if other pictures will be
added to presentation
2. Check Delete cropped area if pictures are cropped
ii. Under Target output select E-mail if presentation will be used on normal computer and

projector
iii. Click OK; click OK
5. Custom Animation = Home  inset  Design | ammations
i. Click on Animations tab iidte: [ No Animatior " H
j.  Click on Custom Animation button to use the preiles ||| =2y custom Animation f—
Custom Animation menu on right side of window Preview Animations
a. Click on what is to animated (i.e., text, graphic, etc.) —E 80 | Custom Animation
b. Click Add Effect (top of Custom Animation window) | [ addeifec -]
Select desired category (i.e., how text/graphic is to enter i iz'”“ ;k ::;::. :
the slide) £ S Concherbontl 195 508 ;
d. Select desired action; observe: | 4 Compress £ Mation Paths »
i. Resulting action on current slide F 5 Diamond
ii. The order of actions is denoted by numbering o iy
iii. Custom Animation menu displays options =
e. Under Modify: Box adjust desired modifications _
i. Start: set when animation will start (click down arrow to view m —
options) . 8
ii. Direction: set direction of the animation . =
iii. Speed: set animation speed iLe B conisogrin.m

f. Click down-arrow to right of animation  ’

i. Click on Effect Options....; click on Effect tab; Under Blinds ]3]
Enhancements: Z_’:‘r;s““" Bk it
a. Click No Sound and select desired sound when bschons | parea 3
each animation begins “:m“'*“‘ —
b. Click Don’t Dim and select color or effect on attsr somneticn [Dontt

Animabe beuk: All at once

previous when next animation begins
c. Click on All at once and select what text will be
animated o] (e ]
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ii. Click on Timing tab
a. Delay: enter how many seconds delay before animation
b. Speed: click down arrow and select the desired speed for the animation
c. Repeat: select any desired repeating of the animation
d. Click OK
g. Click Play at bottom of Custom Animation menu to play the animations on that slide; alter the
animation as needed

6. Slide Transitions Kt E .
a. CI!ck on Anlmatlor_1$ tab B ] __£_|| £_| | -
b. Click down-arrow in Transitions scroll bar =
c. Move cursor over different transitions to view the i
different transitions
d. Click on the desired transition
e. Click on No Sound to select desired sound ‘
f.  Click on Fast to select the desired Transition Speed ] S
g. Click on Apply to All if desired
7. Modify Design Color Scheme
a. Click on Design tab
b. In Theme group, click on Colors
i. Select desired color scheme for the current design (roll over each color scheme and wait;
notice the subsequent change on the design)
ii. Click on desired color scheme
c. Click on Fonts
i. Select desired fonts for the current design (roll over each font and wait; notice the
subsequent change on the design)
ii. Click on desired font
d. In Background group, click on Background Styles
i. Select desired background style for the current design (roll over each background style and
wait; notice the subsequent change on the design)
ii. Click on desired background style
iii. Click Fomat Background (at bottom of Background Styles window) to modify the
background fill (select solids, gradients, picture, textures, etc.); click Reset Background for
current slide design, or Apply to All for all slides
1. For background pictures, click Pictures option to Recolor and adjust the picture
8. Capturing an Image from Internet Explorer for use in PowerPoint
a. InlLE. locate a picture:
i. Right click on the desired image
i. Select Save Picture as...
iii. A Save Image as window appears; rename the image (It is good practice to leave gif or jpg
at the end)
iv. Save the image to a disk, server or the hard drive.
b. Back to PowerPoint:
i. Click on Insert tab; click on Picture
ii. Navigate to saved image; click Insert

4y Transition Sound: | [Mo Sou

E_ﬂ,, Transition Speed: | Fast

Fades and Dissolves

S S

‘-I Wipes
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9. Views
a. Outline Pate 2l ree 51 (0
i. Click on Outline tab on PowerPoint window e ||
ii. View the outline of content on PowerPoint indes\_;.k.sE_:'mm .
iii. Edit and add text to the outline, which will be viewable on ‘ ;:"':E;'::“:':::s“‘;nd g

outline and on appropriate slides chaemaker
1] open PowerPoint
+ Click on PowerPaint icon

iv. Click Slides to again view all slides

i. Clickin Click to add notes below PowerPoint edit window -
ii. Enter desired notes relevant to the slide (notes do not show :
in Presentation mode) T T T
iii. Place cursor just above Click to add notes to see parallel
lines with arrows; click and drag up to increase notes area
c. Slide Sorter
i. At bottom-right of PowerPoint edit window, click on middle
icon to view the slide sorter window
ii. Click and drag slides to desired order
iii. Note the markings under each slide denoting animation,
transition and timing
iv. To return to edit mode, click first icon
d. Presentation
i. Click on the third icon to view the current slide in Presentation mode
ii. To view the presentation mode from the first slide, click Slide Show tab, then click From
Beginning command (far left icon on Ribbon)
iii. To quit presentation mode, press Esc key (or middle icon on SMART Board floating tool bar)

Click to add notes

:20f2 | “Currengy” | 35

N

H H Brinty 2 [%]]
10.Printing e @s
. . . . . . Hame:  [WhelbdesieeEeocs <] properties
a. Click on Microsoft Office Button, go to Print; click Print s o ﬁ}
b. Select appropriate Print range: All, Current, 1-4, etc, et A  pertsry
. R . D ] Copies
c. Print what: select Slides, Handouts, Notes, Outline e e e
(If Ha)ndouts is selected, look to the right, select how mw f;jmmmw ﬂil
page — W Colate
d. Color: Grayscale is a good choice . |t e EE B
. . . . . — P | [Graysca e =]
Clicking Preview button to see what will be printed Dot T
f. Click OK —— — |

11.Saving as a Show (this allows the file to be brought up ONLY in presentation mode; no editing is
permitted; this is great for sharing a show)
a. Save the file as a regular PowerPoint file; this is important so that the file can be edited in the
future
b. Click on Microsoft Office Button; move cursor over Save As...; click on PowerPoint Show
c. Name file and identify location; click Save

12.Create a Handout in Word
a. Click on Office Button to Publish
b. Select Create handouts in Microsoft Word
c. Modify as needed in Word
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